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Guide 193 
Version 1.0 

IT133: SPSS - Introduction 

These notes provide an introduction to using the PC (Windows) version of 
SPSS release 19, which is accessible from the Networked PC service. 

This Guide makes use of example files which are installed on the Networked 
PC service. If you do not use the Networked PC service then you can obtain 
the files from the ITS WWW pages. 
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In this document, the following conventions are used: 
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should replace with particular instances. 

 A typewriter font is used for what you see on the screen. 
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 A bold font is also used where a technical term or command name is used in 
the text. 
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1 Introduction 

1.1 About SPSS 

SPSS is a package for the statistical analysis of data. It is widely used in 
research, teaching and business. It is available worldwide, and versions 
exist for a range of different computers. It is the main statistical package 
available at the Durham University, where both UNIX and PC (Microsoft 
Windows) versions are currently available. 

This Guide provides an introduction to the use of SPSS 19 for Windows 
which runs on the Networked PC service. SPSS for Windows provides a 
graphical environment in which most tasks can be accomplished by 
pointing and clicking with the mouse. The working data file is displayed in 
the form of a spreadsheet in which data may be entered and edited. In 
addition, you can enter syntax commands into a Syntax Editor for those 
tasks which cannot be done from the menu system, or simply if you prefer 
to work with syntax commands rather than with menus. You can also create 
and edit charts for the visual presentation of data. 

1.2 What you should know already 

These notes assume that you are familiar with Microsoft Windows, and 
know how to perform tasks such as accessing commands from the menus 
on the menu bar, selecting items, entering information into dialog boxes, 
and moving, closing, opening and resizing windows. 

1.3 Default working directory 

Before you proceed with this guide you are recommended to create a 
directory in which to hold all the files that you will be working with. In the 
notes that follow, it will be assumed that you are working on the Networked 
PC service and that you have a directory called J:\stats\ in which you will 
save your files. If you are not using the Networked PC service, or if you 
prefer to keep your files in some other directory, then you will need to 
change all references to J:\stats\ to the directory you are using. 

1.4 Example files 

In order to run parts of this tutorial you will need to use some sample files 
that have been prepared for you. If you are using the Networked PC service 
you will find these in the directory T:\its\spss\. Otherwise you will need to 
obtain the files from the ITS WWW pages (see 
http://www.dur.ac.uk/its/info/guides/files/spss/). It is suggested that you 
copy the sample files to your working directory (e.g. J:\stats\) before you 
start. The next section provides information on how to copy these files. 

2 Getting started 

2.1 Starting up SPSS on the Networked PC service 

1 Login to the Networked PC service in the usual way. 

For information on how to login to the Networked PC service see: Guide 5: 
Using the Networked PC service. 

http://www.dur.ac.uk/its/info/guides/files/spss/
http://www.dur.ac.uk/resources/its/info/guides/5npcs.pdf
http://www.dur.ac.uk/resources/its/info/guides/5npcs.pdf
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2 Use Windows Explorer or My Computer to create the directory in 

which you will be working (J:\Stats), and copy the sample files from 

T:\its\spss\ into it. You will not need all the files — a list the required 

sample files is given in Appendix A. 

If you need help with this use the help which is accessible from Start | Help 
and Support.  

3 Select the Start button from the taskbar at the bottom left of the 

screen. SPSS resides under Start | All Programs | Statistics | 

SPSS 19. 

2.2 Starting up SPSS on a stand-alone PC 

4 Start up Windows in the usual way. 

5 Create the directory in which you will be working, and copy the 

sample files from the data disk into it. 

If you need help with this use the help which is accessible from Start | Help 
and Support.  

6 Select the Start button from the taskbar at the bottom left of the 

screen. SPSS normally resides under Start | All Programs | SPSS. 

3 The SPSS windows 

On starting up SPSS you will see first the SPSS Data Editor window:  
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The SPSS Data Editor has the usual components including a title bar, a 
menu bar, a tool bar, and a status bar. It is in the form of a spreadsheet 
marked into rows and columns, and has the title Untitled in the upper left of 
the title bar. This will display the SPSS working data file. You can enter 
and edit data in this window, create and delete variables, and change their 
attributes. 

3.1 Bringing a window to the front 

Note that the Data Editor window has a dark title bar. This indicates that 
this is the active window. Later, in section 5, other windows will be created 
(e.g. the Output Viewer window). There are several ways of moving 
windows to the front or back of the screen display, and of selecting which 
window is to be the active window. One way is simply to use the Alt/Tab 
key combination to scroll through the different windows:  

7 Press the Alt key, and whilst holding this down press the Tab key.  

A set of icons for each window will be shown.  

1 Still holding the Alt key, press the Tab key again and the next icon 

will be highlighted.  

2 Release the Alt key when the icon you wish to display is highlighted, 

and the associated program window will be brought to the front to 

make it the active window. 

3 You can also use the Window menu to select which window is to be 

the active window. Select the Window menu. 

The SPSS windows currently open are listed below the other Window 
commands.  

4 Select the one you want by clicking on it (at present there will only 

be one window available — the SPSS Data Editor). 

3.2 Using the menu bar 

Beneath the title bar in the Data Editor is a menu bar, from which you can 
select commands from the File menu, the Edit menu and so on. Note that 
there is a Help menu. 

1 Open the File menu — point to File and click with the left mouse 

button. 

A list of File commands will be displayed. Some of the commands are grey, 
and some are black. The grey ones are not available to you at this time. 
Notice the Exit command at the bottom of the list. When you have finished 
with SPSS you will need to select Exit from this menu. 

2 Click outside the list of menu commands to close the list as you do 

not need any of these commands for the moment. 

If you inadvertently find yourself in a menu or a dialog box that you don’t 
want, then click on the Cancel button (if there is one) or press the Escape 
(Esc) key. You may have to do this several times in order to close down all 
menus. 
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3.3 Using the tool bar 

Beneath the menu bar in the Data Editor is a tool bar, which consists of a 
number of buttons which provide a quick way of running some of the 
commands. A brief description of the function of each button is displayed in 
the status bar at the bottom left of the application window when the mouse 
pointer is over the button. 

3 Place the mouse pointer over each button in turn, but do not click. 

Notice the description of its function in the status bar (a descriptive 

label will also appear below the button after a short while). 

3.4 Viewing different parts of the content of a window 

Frequently a window will contain more information than can be viewed at 
any one time, and you may need to bring other parts of it into view. You can 
do this in any of the usual ways — using the scroll bars, the Page Up and 
Page Down keys, and the arrow keys. 

1 Experiment with each of the different ways of scrolling the window 

up, down and sideways. 

As you scroll down the top rows of the spreadsheet will disappear, and new 
rows will appear at the bottom of the window (You will be able to see the 
grey row numbers at the left hand end of each row changing.) 

 

4 The working data file 

The Data Editor displays the data in the SPSS working data file in the form 
of a spreadsheet. At present this is blank as you have not yet entered any 
data.  

Consider the following hypothetical data (which you will shortly enter into 
the SPSS working data file), which consists of scores for the variables age, 
sex and income for a sample of 10 people.  

caseid age sex income 

1  38 F  0 

2  27 M  32000 

3  22 X  15000 

4  31 M  40000 

5  99 F  17000 

6  40 F  5000 

7  99 M  21050 

8  28 F  0 

9  39 M  46000 

10  20 M  19000 

 

When you enter the data into the SPSS working data file, the data will 
appear much as it does in the table shown here. There will be a column for 
each variable, each variable will be given a name, and there will be a row 
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for each of the 10 cases in the sample. Each case in the sample has been 
assigned a unique case ID which appears in the first column.  

You will have to choose a name for each variable. Each variable name 
may be up to 8 characters long, may consist of letters and numbers, must 
start with a letter, (and may include a dot, or any of the characters @ # _ $). 
It may not include spaces. Variable names are not case sensitive — age, 
Age and AGE would all be regarded as the same variable. There are some 
reserved words which you cannot use for variable names: 

all and by eq ge gt le lt ne not or to with 

4.1 Entering data into the SPSS working data file 

The SPSS Data Editor has two views – the Data View (spreadsheet), and 
the Variable View. To switch between the two use the tabs at the bottom 
left of the Data Editor window: 

 

 

Choose Data View to display the spreadsheet containing data and use 
Variable View to define variables for data. 

4.1.1 Enter data for the Case ID variable 

2 Click on the Variable View tab. 

The Variable View is shown: 
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3 Click on the top cell in the first column of the Variable View. 

4 In this cell type:  

caseid 

then press Enter. 

The default variable definition will be applied to this new variable, and will 
appear in the Variable View. 

5 Return to the Data View. 

Notice that the variable you have just entered appears above the first 
column of the spreadsheet. 

6 Click in the first cell.  

7 Type the first score  

1 

then press Enter. 

Notice that the score 1.00 now appears in the first cell, and the highlight 
moves down to the next cell. 

8 Now type the second score  

2 

then press Enter. 

9 Repeat this until you have entered all 10 scores. 

 

Note that it does not matter if you make mistakes as you are entering the 
data. You will have the opportunity to correct any errors in the data, or 
change a variable name, later on. 

4.1.2 Enter the data for the Age variable 

1 Using a similar procedure, add the variable age, and enter its data 

into the second column of the spreadsheet.  

4.1.3 Enter data for the Sex variable  

1 Click on the Variable View tab. 

2 Click on the third cell down in the first column. 

3 In this cell type: 

sex 

as the variable name and press Enter. 

Now you have to declare that the scores for this variable are characters not 
numbers. Note that the second column shows the variable type. The default 
is numeric. 

4 Click on the variable type cell for sex: 
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5 In the Variable Type  dialog box change the variable type to String 

and click OK: 

 

Notice that the new type for sex is now String. 

6 Return to the Data View. 

7 Click in the first cell of the third column.  

8 Type the first score 

F 

9 Press Enter.  

It is important that you type this as F rather than f . 

Notice that the score F now appears in the first cell.  

If it won’t accept a score of F, then you probably did not declare this 
variable to be a string variable. Repeat the data definition procedure for the 
sex variable, taking care that you do not omit anything. 

10 Now type the second score 

M 

and press Enter. 

11 Repeat this until you have entered all 10 scores. 

4.1.4 Enter the data for the Income variable 

1 Using a similar procedure to that used for the caseid variable, add 

the variable income and enter the data for the income variable into 

the fourth column of the spreadsheet.  

Note that the default variable definition for income displays the data with 2 
decimal places. Go back to the Variable View and set the numeric type to 
0 decimals. 
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4.2 Check and edit the data in the spreadsheet 

1 Check all the scores you have entered against the original table of 

data. 

If you find an error: 

1 Click in the cell that is wrong. 

2 Type the correct value and press Enter. 

If you can find no errors: 

1 Click in any of the data cells. 

2 Type in a new score and press Enter.  

3 Repeat these two steps to restore the correct value. 

Notice how easy it is to correct the data in the spreadsheet. Take care 
though — it is equally easy to corrupt a data file! 

4.3 Saving the SPSS working data file 

Now that you have entered all the data, you need to save them in a file. 
The Save and Save As commands save all the data in the SPSS working 
file (as displayed in the Data Editor), together with all the data definition 
information (i.e. the variable names), as an SPSS data file. 

1 Select File | Save As.  

The Save Data As dialog box will open. 

2 Type  

sample1 

as the name for your file. 

3 If necessary change the drive and/or directory to where you want to 

save your data file (e.g. use your J:\stats directory). 
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4 Click on Save.  

The SPSS working data file will be saved on your disk as an SPSS data 
file, which you will be able to retrieve later. 

Note that SPSS has added the extension .sav to the name you gave for 
your file. It is strongly advised that you keep to the standard conventions for 
naming files so that all SPSS data files will have names ending in .sav, and 
all files ending in .sav will be SPSS data files. This way you will be able to 
distinguish them from other sorts of files. See Appendix B for a summary of 
recommended file naming conventions. 

Notice that the title bar of the Data Editor now displays the name you have 
given for your SPSS data file. 

4.4 Printing the data 

It is often easier to check the data that you have entered into SPSS with a 
printed listing rather than viewing it on the screen.  

1 Select File | Print. 

2 Check the default printer is the one you want.  

3 Click on OK. 

The font and size of characters will be determined by the font and size of 
the characters displayed in the Data Editor. If you want to change these 
then select View | Fonts and choose your required Font in the dialog box. 
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5 Exploratory data analysis 

Now that you have some data in the working data file, you can begin to do 
some statistical analysis. The first step in any analysis should be to carry 
out some exploratory data analysis. This will take the form of obtaining 
summary statistics on the data using the Descriptives command for the 
numerical data, and the Frequencies command for the categorical (string) 
data. At this point you try to get the feel of your data by asking some simple 
questions about it. 

5.1 The Descriptives command 

For numerical data such as age and income (which are based on an 
underlying continuous variable) you may like to know what is the mean 
value in your sample, or the least, or the greatest. You may also like to 
have some measure of the spread of the scores such as the standard 
deviation. To answer all these questions you can use the Descriptives 
command. 

1 Select Analyze | Descriptive Statistics | Descriptives.  

The Descriptives dialog box will open:  

 

You must now specify which variables you want descriptive statistics for.  

2 Click on age. 

3 Click on the select button:   

4 Click on income, then click on the select button. 

5 This will put the variables age and income in the Variable(s): box.  

6 Click on OK. 

The following descriptive statistics on the variables selected will appear in 
the Output Viewer. Look at the results and use them to answer your 
questions about the data. 
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Note that by clicking on the Options button in the Descriptives dialog box 
you can obtain other statistics besides those shown here. You can also 
control the order in which the results are displayed. By default they are 
displayed in order of the variable list. 

5.2 Missing Values 

Notice that the maximum age is given as 99, and if you look at the data you 
will see that this value has been included in the calculation of the mean and 
other statistics. However the value 99 was not intended to be a valid score, 
but was intended to indicate that for some reason this score was missing — 
perhaps because the person refused to answer the question. So now you 
must tell SPSS that a score of 99 for the variable age is to be treated as a 
missing value. You will do this using the Missing Values command.  

An alternative way to indicate that a score is missing is to leave the 
corresponding cell blank. SPSS will automatically treat blanks as missing. 

However there may be times when a score might be missing for one of a 
number of different reasons (for example, a question was not relevant, or 
the person refused to answer) and you might want to record the reason. In 
this case you would have to code each reason with a different value. 

For example:  

99 = refused to answer 

98 = question not relevant 

Then you would use the Missing Values command to tell SPSS that both 
these values for the particular variable are to be regarded as missing. Note 
that the missing value must be appropriate for the variable: you must use a 
numerical missing value for a numerical variable, a character missing value 
for a character variable. 

5.2.1 Declaring Missing Values 

Now tell SPSS that the value 99 for age is to be treated as missing. 

1 Click on the Variable View tab. 

2 Click on the Missing values column for age. 

The Missing Values dialog box will open. 

3 Click on Discrete missing values. 

4 Type 

99 

D e s c rip tiv e  S ta tis tic s

1 02 0 .0 09 9 .0 04 4 .3 0 0 02 9 .6 2 7 5

1 0.0 04 6 0 0 0 .0 01 9 5 0 5 .0 01 5 9 1 1 .7 4 3 6

1 0

A G E

IN C O M E

V a lid  N  ( lis tw is e )

NM in im umM a xim umM e a n

S td .

D e v ia tio n
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as the first missing value. 

 

5 Click on OK. 

6 Now repeat the Descriptives command. 

Notice how declaring 99 as a missing value for age affects the results. 

Notice that there are now only 8 valid scores for age, and both the mean 
and standard deviation are much smaller than before. This is because the 
99 scores are now excluded from the calculation. So you will have to revise 
the answers to your questions about the data. 

5.3 The Frequencies command 

For variables such as sex, which have a small number of discrete values 
only, a useful way of summarising the data is simply to count how many 
times each value occurs. This can be done with the Frequencies command. 

1 In the Data Editor, select Analyze | Descriptive Statistics | 

Frequencies.  

The Frequencies dialog box will open. 

You must now specify which variables you want frequencies statistics for.  

2 Click on sex. 

3 Click on the select button:  

4 Click on OK. 

The following frequencies statistics on the variable selected will appear in 
the Output Viewer: 

 

S t a t i s t i c s

S E X

1 0

0

V a l i d

M i s s i n g

N
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Notice that the value X is treated exactly the same as F and M. Clearly the 
value X for sex should be regarded as missing in much the same way as 
the 99 for age is missing. 

5 Declare X as a missing value for sex. 

6 Run the Frequencies command again and notice how declaring X as 

a missing value affects the results. 

Notice how this affects the output. 

Note that if the data consisted of a mix of upper case and lower case (F f M 
m X x), then these would be seen as 6 different values and would be 
counted separately. 

You should now save the changes to the SPSS working data file. 

1 Make sure the Data Editor is active, then select File | Save. 

This will save the missing values declarations, plus any other changes you 
may have made since the last time you saved the file. Notice that this time 
you do not have to provide a filename. SPSS uses the filename that 
appears in the title bar at the top of the Data Editor. The previous contents 
of this file will be overwritten.  

6 Applying labels to your data 

You can provide descriptive variable and value labels which can make your 
output much more readable/meaningful.  

Variable labels give additional information about variables and can be up to 
256 characters long. 

Value labels give additional information about values and can be up to 60 
characters long. 

1 Click on the Variable View tab. 

2 Click Label for sex. 

3 Enter in the cell: 

Person’s Sex 

as the Variable Label and press Enter. 

4 Click on the  Values cell for sex and enter: 

F 

as the Value. 

S E X

44 0 .04 0 .04 0 .0

55 0 .05 0 .09 0 .0

11 0 .01 0 .01 0 0 .0

1 01 0 0 .01 0 0 .0

F

M

X

T o ta l

V a l id

F r e q u e n c yP e r c e n t

V a l id

P e r c e n t

C u m u la t iv e

P e r c e n t
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Note that this must be capital F not lower case f. 

5 Type 

Female 

as the Value Label. 

6 Click on Add.  

7 Repeat for M – Male. 

 

When you have declared all the labels you want for this variable: 

8 Click on OK in the Value Labels dialog box. 

Now that you have provided variable and value labels for sex, SPSS will 
use these in the display of results. 

9 Repeat the Frequencies command on the variable sex.  

Notice how the labels improve the information content of the output. 

10 Add variable and value labels to any other variables you wish. 

The labels you have provided become part of the working data file.  

To display value labels in Data View select the menu View | Value Labels. 

11 Use the File | Save (from the Data Editor) command to save these 

changes to the SPSS data file. 
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7 The Output Viewer 

Often there will be some results in your Output Viewer that you want either 
to print, or to save to a file for inclusion in a report of your findings. Usually 
there will also be some material in the Output Viewer that you want to 
discard, or you may wish to add something — perhaps some comments 
about your interpretation of the results, or about any unusual scores. 

7.1 Editing the Output Viewer 

SPSS provides simple editing of the text in the Output Viewer.  

You can point and click with the mouse to position the text insertion point, 
then insert new text, a title or heading using the Insert menu. You can also 
delete text character by character using the Backspace key (to remove the 
character to the left of the text insertion point), or the Delete key (to remove 
the character to the right of the text insertion point). 

Text, titles and headings are often held as objects. To edit these double-
click on them with the mouse. 

You can click-and-drag the mouse over any amount of text to select it. 
Then you can delete, copy or move the selected text in the standard way 
using the Cut, Copy, Paste After or Delete commands from the Edit 
menu. To undo any action, use the Edit | Undo menu. 

1 Make sure the Output Viewer is active, then experiment with some 

editing operations — for example delete some text, and add some 

new text, move or copy some text from one location to another. 

Tables in the Output Viewer are stored as groups of text – to edit double 
click a table to make it editable then double click on the individual text item 
to start editing.  

There may be times when you want to delete everything in the Output 
Viewer. Use Edit | Select All to highlight all text, tables etc, then choose 
Edit | Delete — but do not do this at present! 

7.2 Saving the Output Viewer 

You can save the whole content of the Output Viewer, or you can select 
some items and save just what you have selected. 

1 If required, select the items in the Output Viewer that you want to 

save. 

2 Select File | Save As.  

The Save SPSS Output As dialog box will open. 

3 Type  

output1 

as the name for your file. 

4 If necessary change the drive and/or directory to where you want to 

save your output (e.g. J:\stats\). 
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5 Click on Save.  

The output will be saved as an SPSS output file (*.spv) , which you will be 
able to retrieve later. 

Note that SPSS has added the extension .spv to the name you gave for 
your file. It is strongly advised that you keep to the standard conventions for 
naming files so that all SPSS output files will have names ending in .spv, 
and all files ending in .spv will be SPSS output files. This way you will be 
able to distinguish them from other sorts of files. See Appendix B for a 
summary of recommended file naming conventions. 

Notice that the title bar of the Output Viewer now displays the name you 
have given for your SPSS output file. 

SPSS output files are in a format only SPSS can read. To save as text or 
html for use in other applications: 

1 Select the text or tables you wish to export (do not select anything if 

you want to export everything in the Output Viewer). 

2 Choose File | Export. 

3 In the Export Output dialog box choose File Type. 

4 Click browse to choose directory and filename to write to. 

5 Click Save then OK. 

7.3 Printing the Output Viewer 

You can print the whole content of the Output Viewer, or you can select 
part of it and print the selection only. 

1 If required, select the items in the Output Viewer that you want to 

print. 

2 Select File | Print. 

3 In the Print dialog box, select the printer you want.  

4 Click on Properties to change the orientation and then click OK. 

5 If you highlighted some text before you clicked on File | Print, then 

you will notice that the default is to print just the Selection. If you 

want to print everything in the Output Viewer, you will need to 

change this to All visible output. 

6 In the Print dialog box click on OK to print.  

The font and size of text output will be determined by the font and size of 
the characters displayed in the Output Viewer. To change these: 

1 Select Edit | Options and select the viewer tab.  

2 Choose Text Output from the Item: pull down menu. 

3 Change the Title Font and Text Output Font as required. 

4 Click OK when complete. 

To change the font and size of characters in tables: 



 

Guide 193: IT133: SPSS - Introduction 17 
 

1 Click on the table in the SPSS viewer to select it. 

2 Choose Edit | SPSS Pivot Table Object | Edit. 

3 Select Format | Table Properties. 

4 Click on the Cell Formats  tab and select the required text, font and 

size. 

5 Click on OK. 

8 Using the online help 

SPSS for Windows includes a hypertext based Help system. It includes 
information on how to run SPSS, what commands to use, how to interpret 
your results, and a tutorial. The best way to learn about the Help system is 
to use it.  

There are several ways to access the Help system: 

 Select Help from the menu bar. 

 Click on the Help button in an SPSS dialog box for information about the dialog 
box and what it can do. 

The Help system also provides information on how to use the Help system! 

1 Choose Help | Topics. 

2 Make sure the Contents tab is selected. 

3 Double-click on the Getting Help entry and double-click on a topic 

of interest. 

Spend some time exploring the Help system, and run through parts of the 
tutorial by selecting Help | Tutorial. 

When you are finished with the Help system, close it down by clicking on 
the X button in the top right corner of the help dialog box. 

9 Ending the first SPSS session 

9.1 Closing down SPSS 

1 Select File | Exit.  

If you have made any changes to the working data file since you last saved 
it you will be asked if you want to save the changes.  

2 Click on Yes if there are changes you want to save, otherwise click 

on No. 

If you have made any changes to the Output Viewer since you last saved it, 
you will be asked if you want to save these changes. 

3 Click on Yes if there are changes you want to save, otherwise click 

on No. 

The SPSS processor will stop and you will be returned to the Windows 
desktop. 
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If you now open Windows Explorer and select the directory in which you 
saved your SPSS files, you should see the files sample1.sav (the SPSS 
data file), and output1.spv (the text that you saved from the Output 
Viewer). 

9.2 Retrieving a saved data file 

Before you conclude this session, start-up SPSS again and retrieve the 
data file that you have been working on. 

1 Start-up SPSS as you did before 

2 Select File | Open | Data.  

3 In the Open File dialog box, change to the drive and directory where 

you saved your SPSS files (if necessary), click on the name of your 

data file (sample1.sav), then click on Open.  

This will load the file you saved earlier and you should see the data 
displayed in the Data Editor. 

4 Repeat some of the exploratory data analysis that you did earlier. 

Provided you saved the data after declaring the missing values you should 
find that the missing values are treated correctly — they should be 
excluded from the summary statistics produced by the Descriptives 
command, and counted as missing by the Frequencies command. 

5 Exit from SPSS when you have finished. 

9.3 Logging out from the Networked PC service 

If you have been using the Networked PC service then you must also 
remember to exit properly from this service when you have finished your 
session. 

1 After exiting from SPSS, close down your session by clicking the 

Start button at the bottom left of the screen and choosing Logout. 

You will be asked to confirm that it is OK to logout.  

2 Click on the Yes button (or press the Enter key). 

10 Reading data from an ASCII text file 

It is not always convenient to key your data directly into the SPSS Data 
Editor. It may be that your data have been generated by another program 
and are available as a spreadsheet or a text file. 

For this session you will read some data from a sample text data file that 
has been prepared for you. This file, called survey1.dat1 , contains the 
hypothetical data that you will be working on for this session. It will be 
helpful to take a look at what is in it. You can use Notepad for this. 

                                                           
1
 If you are using the Networked PC service you will find these in the directory T:\its\spss\ 

on the server. If you are not using the Networked PC service then you will need to the files 
from the ITS WWW pages (see section 1.4). 
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1 If you have not already done so, login to the Networked PC service 

or start up Windows on your personal computer in the usual way. 

2 Choose Start | All Programs | Accessories | Notepad. 

3 In the Notepad application window, select File | Open. 

4 In the Open dialog box change the Files of type: to All Files  and 

select the drive and directory to where the sample data file is (e.g. 

J:\stats\). 

5 Select the name of the file survey1.dat, then click on Open. 

The file will be loaded and you will see the first few lines of the file on your 
screen. There are in fact 50 lines of data in the file. 

The data consist of 8 scores for each of 50 people. The following table 
gives, for each score, a name, the type (whether numeric or string), the 
number of decimal places (if numeric), a description of the score, and any 
missing value scores. 

Variable Type Decimal 

Places 

Variable label Missing values 

Person Numeric 0 Identifying code  

Sex String  Sex X 

Age Numeric 0 Age 99 

Marstat String  Marital status  

Nkids Numeric 0 Number of children 9 

Income Numeric 0 Annual income 99999 

Height Numeric 1 Height 99.9 

Sheight Numeric 1 Height of spouse 99.8, 99.9 

 

You are now going to get SPSS to read these data. 

1 Close Notepad — select File | Exit. 

2 Start-up SPSS in the usual way. 

10.1 The Read Text Data command 

1 Select File | Read Text Data 

2 Change the drive and directory (if necessary) to where the data file 

is stored (e.g. J:\stats\), then select the data file survey1.dat. 

3 Click on Open.  

The Text Import Wizard will be displayed: 
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4 Click on Next. 

5 Select Delimited and No variable names included and click Next. 

6 Select to First case on line 1, Each line represents a case and All 

of the cases then click Next. 

7 The next screen shows how the data will look like in SPSS. Click 

Next. 

8 Select each variable heading in turn (from the Data preview) and 

enter a Variable name (use the definitions from the table at the 

beginning of this section). Also check that the Data Format is 

correct. 

9 Click Next. 

10 Click Finish.  

After a few moments you will see the scores from the file survey1.dat 
appearing in the Data Editor.  

11 Look at the scores carefully to make sure that they have been read 

correctly. 

The first few rows of the data should look like this: 
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If the scores have not been read correctly, repeat the Read Text Data 
command and correct the entries in the Text Import Wizard. 

10.2 Save the working data file 

When you are satisfied that the data have been read correctly, save the 
working data file as an SPSS data file. 

1 Select the File | Save As command.  

2 In the Save Data As dialog box, type  

survey1 

as the name for your new file. 

3 If necessary, change the drive and/or directory to where you want to 

save your data file (e.g. J:\stats\). 

4 Click on Save. 

This will save the data together with the variable names that you have 
provided as an SPSS data file. Next time you want to work on these data, 
you will be able to use the File | Open command instead of repeating the 
Read Text Data command. 

10.3 Assign missing values 

Some of the variables have values that need to be declared as missing. 

1 Declare as missing the appropriate values of all the variables that 

have missing values (use the table at the beginning of this section).  

Reminder: use the Variable View tab (section 4.1). 
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2 Run the Frequencies or Descriptives command (as appropriate) 

on the variables with missing values.  

3 Look at the output to confirm that the missing values have been 

declared correctly.  

If they are wrong, then you will need to repeat declaring Missing Values 
with appropriate modifications. 

10.4 Apply variable and value labels 

You will also need to apply variable and value labels. Variable labels are 
shown in the description column of the table at the beginning of this 
section. Value labels are: 

Sex: F = Female, M = Male 

Marstat: M = Married, S = Single, D = Divorced, W = Widowed 

1 Save these changes to the SPSS data file using File | Save. 

10.5 Data validation 

It is a very important part of any analysis that you validate the scores at an 
early stage.  

If there are errors that need to be corrected, then the sooner you can 
identify them and correct them the less likely you are to come to false 
conclusions about your data. For instance there may be simple mistakes in 
the coding or entering of the data. Unusual scores may indicate a problem 
with the procedure used to collect the data, which might require a possible 
re-evaluation of the methods used. Alternatively there may be genuinely 
unusual scores that need special treatment. At the very least, the early 
identification of unusual values can help to reduce the amount of re-
analysis that you will have to do.  

1 Apply the Frequencies command to the variables that have discrete 

(categorical) values. 

2 Apply the Descriptives command to the other scores. 

3 Look at the output. 

It is very important to look at the output! Do the results indicate the 
presence of any unusual scores? Are you getting the results you expect? 
Of course you will need to know something about your data in order to 
know what results you should expect! So ask yourself some questions of 
the data. For example: 

 Should you have roughly equal numbers of males and females? 

 What sort of values would you expect for the minimum and maximum values for 
age, and average age? 

 What sort of values would you expect for the minimum and maximum values for 
income, and average income? 

 You should find that there are no spouse values for people who are not married. 

Finding answers to simple questions like these will help you to get the feel 
of your data. When working with your own data you would need to check 
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any unusual scores against the original source of the data. You would 
correct them if they were wrong, or if not, consider why they were unusual 
and whether you need to modify your method of data collection or rethink 
your plans for the analysis of the data. 

11 Reading data from an Excel file 

Another popular option for getting data into SPSS is to open data in Excel 
format. This short section will show how to do this. 

First look at a .xls file in Excel: 

1. Open Excel (Start | Microsoft Excel) 

2. Chose File | Open 

3. Navigate to T:\its\spss\ and highlight demo.xls. 

4. Click Open. 

Look at the data in Excel. Note that the first row contains column headings 
(i.e. variable names), the column range is from A to AB and there are 6401 
rows. 

Now open this data in SPSS: 

5. Close Excel 

6. In SPSS Choose File | Open | Data 

7. Set Files of type to Excel (*.xls). 

8. Navigate to T:\its\spss\ and highlight demo.xls. 

9. Click Open. 

10. In the dialog box that appears make sure that the first row of data 
are read as variable names. 

11. Make sure the correct Worksheet is selected (there is only one in 
this example). 

12. Finally select an alternative Range (i.e. not all of the data if 
necessary) and click OK. 

The Excel data will be opened in SPSS and can be saved as a .sav if 
required.  
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Appendix A: Sample files 

File type File names 

ASCII data files survey1.dat, survey2.dat 

SPSS syntax file survey1.sps 

SPSS data files Survey3.sav 

Appendix B: Recommended naming conventions for SPSS file types 

 

extension used for text file? 

.dat ASCII data file yes 

.sav SPSS data file no 

.sps SPSS command file yes 

.spv SPSS output listing No 

.sct SPSS chart file No 

Note that you can view and edit the text files using Word, Notepad or any 
other text editor. You should not attempt to view or edit the data in an 
SPSS data file except by opening the file from within an SPSS session. 
SPSS data files (.sav), SPSS output files (.spo) and SPSS chart template 
files (.sct) are in a special format that only SPSS can read. 

Appendix C: Operators 

Arithmetic operators  Relational operators  Logical operators 

+ addition  < less than  & And: both 

conditions must 

be true 

- subtraction  > greater than    

* multiplication  <= less than or equal  | Or: either 

condition must 

be true 

/ division  >= greater than or 

equal 

   

** exponentiation  = equal  ~ Not: reverses 

outcome  

true <-> false 

() order of operations  ~= not equal    
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